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YAYIM KURALLARI  

 

1.  Amisos Dergisi, Ondokuz Mayıs Üniversitesi Arkeoloji Bölümü Öğretim Üyelerinden 

Doç. Dr. Davut Yiğitpaşa ve Dr. Öğr. Üyesi Akın Temür tarafından, yılda iki kez yayımlanan 

ve  tüm konferanslarda sunulan tebliğlerin metinlerini, bilimsel yenilik getiren, 

özgün makalelerini ve kitap eleştirilerini içeren İnternet üzerinden yayımlanan uluslararası 

hakemli bir dergidir. 

2. Yayımlamak üzere dergiye verilen yazılar, yazarın tercihine göre Türkçe, 

Almanca, İngilizce, Rusça olabilir. Daha önce başka bir yerde yayınlanmamış olması 

gereken makaleler; Times New Roman, tek satır aralıklı, 12 punto; sayfa sınırlaması yoktur. 

Bibliyografik referanslar metin içerisinde veya sayfa altında verilebilir. Dipnotlar 10 punto 

olarak verilmelidir. Ancak bazı alanların gereği olarak yazım esnasında özel font kullanılmış 

ise, bu fontlar makale ile birlikte gönderilmelidir.  

3. Makalelere İngilizce ve Türkçe 200 kelimelik özet ve 5 anahtar kelime (Türkçe 

ve İngilizce olarak) eklenmelidir. 

4. Makale içerisinde yer alacak fotoğraf, çizim ve haritaların 20'yi aşmamasına 

özen gösterilmelidir. 

5. Fotoğraf ve çizimlerin açıklamaları, ayrıca alıntı olanların da kaynakları belirtilerek 

ayrı bir sayfada gönderilmelidir. 

6. Dijital formatta gönderilecek görsel malzemenin çözünürlüğü en az 300 pixel/inch, uzun 

kenarı en az 15 cm, tam sayfa kullanılacak bir fotoğraf ya da çizim söz konusu ise en az 22 

cm olmalıdır. 

 7. Makale, PC ya da Macintosh ortamlarında, Microsoft Word 2010 ve üzeri 

versiyonlarda hazırlanmış olmalı; PDF formatlı bir örneği ile birlikte derginin e-mail 

adresine ulaştırılmalıdır (amisos.dergi@gmail.com). 

Makalede sayfa düzeni şu şekilde olmalıdır:  
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Üst 
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boşluğu 

Sağ 
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Sol 

kenar 

boşluğu 

Satır 

aralığı 

12 punto 10 punto 6 nk 1.25 cm 2,5 cm 2,5 cm 2,5 cm 2,5 cm  
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8. Makale içerisindeki bibliyografik göndermeler makale sonunda ve aşağıda 

verilen örneklerdeki sitemde hazırlanmalıdır: 

Dinçol, A. – B. Dinçol 1992 “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten – E. 

Akurgal – H. Ertem – A. Süel (eds.), Hittite and other Anatolian and Near Eastern Studies in 
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Honour of Sedat Alp, Ankara: 109-117. 

Karaosmanoğlu, M. 2010 “Yeni Bulgular Işığında Altıntepe Urartu Tapınağı”, XV. Türk Tarih 

Kongresi I, Ankara: 209-220. 

Öniz, H. 2008 Arkeolojik Sualtı Araştırmacılığına Giriş İçin Eğitim Metodolojisi, 

Selçuk Üniversitesi, Sosyal Bilimler Enstitüsü, Arkeoloji Anabilim Dalı, (Yayınlanmamış 

Yüksek Lisans Tezi), Konya. 

Temür, A. 2015 “Thoughts on a Grave Stele From The Classical Period in Samsun 

Museum”, Belleten 286/LXXIX: 817-826. 

Yakar, J. 2003 “Identifying Migrations in the Archaeological Records of Anatolia”, 

B. Fischer – H. Genz – E. Jean – K. Köroğlu (eds.), Identifying Changes: The Transition 

from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of the 

International Workshop Istanbul, Nowember 8-9, 2002, Istanbul: 11-19. 

Yiğitpaşa, D. 2016 Doğu Anadolu Geç Demir Çağı Kültürü, Ankara. 

 

Internet Kaynakları aşağıdaki gibi verilmelidir: 

URL 1 http://imgkid.com/tibial-fibular-notch.shtml 

9. Bibliyografik referanslar metinde parantez içinde (Yiğitpaşa 2016: 45-48) ya da 

dipnotta   yazar soyadı, yayın tarihi ve gönderme yapılan sayfa olarak verilmelidir, Temür 

2015: 817. 

10. Yılda Aralık ve Haziran olarak çıkan süreli yayınımıza verilecek makaleler, söz konusu 

dönem içerisinden önce editörlere teslim edilmelidir. 

11. Dergiye gönderilen makale, yayıma uygunluk açısından incelendikten sonra (yayıma 

uygun görülmeyen makaleler sürece dahil edilmez) iki hakeme gönderilir. Hakemlerin 

değerlendirmeleri sonucunda iki yayımlanabilir raporu alan makale, dergi yönetimince uygun 

görülen bir sayıda yayımlanır. Hakem raporlarının birisinin olumlu, diğerinin olumsuz 

olması durumunda makale üçüncü bir hakeme gönderilir. Bu durumda makalenin yayımlanıp 

yayımlanmamasına üçüncü hakemin raporuna göre karar verilir. (Dergiye gelen makalelerin 

yoğunluğu sebebiyle değerlendirme ve yayım süreçleri farklılık arz edebilmektedir.) 

12. Makaleler, hakemlere doğrudan sistem üzerinden (yazarın yüklediği dosyada değişiklik 

yapılmadan) yönlendirilmektedir. Makale üzerinde yazar-hakem gizliliğini sağlama adına 

makalenin sahibini tanımlayıcı herhangi bir bilgi olmamalıdır. 

 

 

Makalelerde kullanılacak kısaltmalarda TDK yazım kılavuzu esas alınmalıdır. 

Bu ilkelere uymayan makaleler kesinlikle değerlendirilmeye alınmayacaktır. The Amisos 

Journal / Amisos Dergisi, gönderilen makaleleri yayımlayıp yayımlamama, gerekli gördüğü 

http://imgkid.com/tibial-fibular-notch.shtml
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durumlarda makaleler üzerinde düzeltmeler yapma hakkına sahiptir. Gönderilen yazıların 

yayımlanma hakkı dergi yönetimine aittir. Dergide yayımlanmış bir yazının hukukî 

sorumluluğu ise yazarına aittir ve dergiyi ilgilendirmez. Dergide yayımlanan yazılar, dergi 

yönetimin yazılı izni olmadan hiçbir şekilde çoğaltılamaz ve başka bir yerde (matbu olarak 

veya internet ortamında) tekrar yayımlanamaz. Dergiye makale gönderen yazar, bu ilkeleri 

kabul etmiş sayılır. 

 

MAKALELERİN GÖNDERİLMESİ 

Yukarıdaki ilkelere uygun olarak hazırlanmış makaleler, MAKALE GÖNDER SİSTEMİ 

üzerinden gönderilmelidir. E-mail yoluyla gönderilen makaleler dikkate alınmamaktadır. 

"MAKALE GÖNDER SİSTEMİ"nden makale göndermek için: 

* ULAKBİM/DergiPark’a üye olduktan sonra, kullanıcı adı (sisteme kaydedilen e-mail 

adresi) ve şifre ile sayfaya girilmelidir. 

* Açılan sayfada "makale gönder" bölümü açılarak ilgili boşluklar doldurulmalıdır. 

* Makale word dosyası halinde, yazar bilgileri olmadan sisteme yüklenmelidir. Kör hakemlik 

sürecinin daha sağlıklı yürütülebilmesi için yazarlarımızın bilgilerini paylaşmamalarına 

dikkat etmeleri gerekmektedir. Ayrı bir word dosyasında yazar bilgileri eklenebilir. 

Yazar bağımsız hakem değerlendirmesinin sağlanması 

Başvuruların yazar bağımsız değerlendirilmesi, yazar ve hakem kimliklerinin birbirlerine 

bildirilmemesi için gayret gösterilmektedir. Bu amaçla sisteme dosya gönderen yazar, editör, 

hakem gibi kişilerin metin ve dosyalar ile ilgili aşağıdaki noktalara dikkat etmeleri gerekir. 

Yazarlar metinde adları ve kurumları geçen yerleri silmelidirler. Sayfa altı notları vb yan 

metinler dahil olmak üzere Mikrosoft belgeleri saklanır iken dosya bilgileri içine kişisel 

bilgiler de yazılır. Bu nedenle ya bu kişisel bilgiler belge özelliklerinden bulunup silinmeli, 

ya da aşağıdaki sıra ile belge kişisel bilgi içermeyecek biçimde yeniden kaydedilmelidir. 

(File > Save As > Tools (or Options with a Mac) > Security > Remove personal information 

from file properties on save > Save) (Dosya > Farklı Kaydet > Araçlar > Güvenlik > Kişisel 

bilgileri silerek kaydet > Kaydet) 

PDF dosyalarda da Adoba Acrobat ana menüsünden belge özellikleri seçilerek, yazar adı 

silinmelidir. 
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PUBLICATION INSTRUCTIONS 

 

1. Amisos Journal is a journal containing two articles published twice a year, including texts 

of papers presented at all conferences, scientific articles, original articles and book critiques 

by Assoc. Prof. Dr. Davut Yiğitpaşa and Dr. Assist. Prof. Akın Temür of the Department of 

Archeology of the University of Ondokuz Mayis. 

2. The manuscripts given for publishing can be in Turkish, German or English according to 

the author's preference. Articles should not have been published elsewhere; Times New 

Roman, single line spacing, 12 pt; there is no page limit. Bibliographic references can be 

given in the text or at the bottom of the page. Footnotes should be given in 10 points. 

3. The articles should include a summary of 200 words in English and Turkish and 5 

keywords (in Turkish and English). 

4. Care must be taken not to exceed 20 photographs, drawings and maps to be included in the 

article. 

5. Explanations of photographs and drawings should also be sent on a separate page, 

specifying the sources of the quotations. 

6. Resolution of visual material to be sent in digital format should have at least 300 pixels / 

inch, a long edge at least 15 cm., a full-page photo or drawing, and a minimum of 22 cm.  

7. The article should be prepared in Microsoft Word 2010 and above, in PC or Macintosh; It 

should be sent to the e-mail address of the magazine along with a sample of the PDF format 

(amisos.dergi@gmail.com). 

The article page layout should be as follows: 

Text 

size 

Footnote 

size 

Paragraph 

spacing 

Paragraph 

indent 

Top 

margin 

Bottom 

margin 

Right 

margin 

Left 

margin 

Line 

spacing 

12 

points 

10 

points 

6 nk 1.25 cm 2,5 cm 2,5 cm 2,5 cm 2,5 cm  

 

1,5 

 

8. Bibliographic referrals in the article should be prepared at the end of the article and in the 

following examples: 

Dinçol, A. – B. Dinçol 1992 “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten – E. 

Akurgal – H. Ertem – A. Süel (eds.), Hittite and other Anatolian and Near Eastern Studies in 

Honour of Sedat Alp, Ankara: 109-117. 

Karaosmanoğlu, M. 2010 “Yeni Bulgular Işığında Altıntepe Urartu Tapınağı”, XV. Türk Tarih 

Kongresi I, Ankara: 209-220. 

Öniz, H. 2008 Arkeolojik Sualtı Araştırmacılığına Giriş İçin Eğitim Metodolojisi, 

Selçuk Üniversitesi, Sosyal Bilimler Enstitüsü, Arkeoloji Anabilim Dalı, (Yayınlanmamış 

Yüksek Lisans Tezi), Konya. 
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Temür, A. 2015 “Thoughts on a Grave Stele From The Classical Period in Samsun 

Museum”, Belleten 286/LXXIX: 817-826. 

Yakar, J. 2003 “Identifying Migrations in the Archaeological Records of Anatolia”, 

B. Fischer – H. Genz – E. Jean – K. Köroğlu (eds.), Identifying Changes: The Transition 

from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of the 

International Workshop Istanbul, Nowember 8-9, 2002, Istanbul: 11-19. 

Yiğitpaşa, D. 2016 Doğu Anadolu Geç Demir Çağı Kültürü, Ankara. 

 

Internet Kaynakları aşağıdaki gibi verilmelidir: 

URL 1 http://imgkid.com/tibial-fibular-notch.shtml 

9. Bibliographic references should be given in parentheses in the text (Yiğitpaşa 2016: 45-

48) or footnote author surname, publication date, and referenced page, Temür 2015: 817. 

10. Articles to be given periodicals published in December and June in the year must be 

submitted to the editors before the said period. 

11. The submitted article has been sent for publication appropriateness (articles not found 

appropriate for publication are not included in the process) will be sent to two referees after 

reviewing. As a result of the evaluations of the referees, the article which received two 

publishable reports is published in a number deemed suitable for the management of the 

journal. If one of the referee reports is positive and the other is negative, the article will be 

sent a third referee. In this case, the publication of the article should be decided according to 

the third referee report. (Evaluation and publication processes may vary due to the intensity 

of the articles coming from the journal.) 

12. The articles are directed to the referees directly through the system (without any changes 

to the file the author uploads). There should not be any descriptive information on the article 

in order to provide author-referee privacy. 

 

Abbreviations to be used in the articles should be based on the TDK writing guide. 

Articles that do not comply with these principles will not be taken into consideration. The 

Amisos Journal reserves the right to publish and not to publish the submitted articles, and to 

make corrections to the articles when it deems necessary. The right to publish of the 

manuscripts belongs to the journal management. The juridical responsibility of a published 

article in the journals belongs to the author and does not concern the journals. Articles 

published in the journal can not be reproduced in any way without the written consent of the 

journal management and can not be reproduced elsewhere (in print or on the internet). The 

author who submits articles to the journal is considered to have accepted these principles. 

http://imgkid.com/tibial-fibular-notch.shtml
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 SUBMITTED ARTICLES 

Articles prepared in accordance with the above principles should be sent via the 

SUBMISSION SENDING SYSTEM. Articles submitted via e-mail are not considered. To 

submit an article from the " SUBMISSION SENDING SYSTEM": 

* After subscribing to ULAKBİM/DergiPark, you should enter the page with 

username (e-mail address saved in system) and password. 

* In the opening page, the "send article" section should be opened and the related 

spaces should be filled in. 

* The article should be loaded into the system as a word file. In order for the blind 

arbitration process to be carried out better, the authors should be careful not to share their 

knowledge. Author information can be added in a separate word file. 

 

Author independent peer review 

Independent evaluation of the applications of the author, authors and referees are not being 

reported to each other. For this purpose, people who send files to the system, such as authors, 

editors, referees should pay attention to the following points about text and files. 

Authors should delete names and institutions in the text. The page information is also written 

into personal information while the page is stored in the Microsoft documents including sub-

texts etc. Side texts. Therefore, either these personal information must be found and deleted 

from the document properties, or the document in the following order should be re-recorded 

so that it does not contain any personal information. (File> Save As> Tools> Security> 

Delete Personal Information> Save) 

 

In PDF files, the author name should be deleted by selecting document properties from the 

Acrobat main menu. 

 


